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P A R T  I  ( G E T T I N G  S T A R T E D )  

Introducing TriCaster™ Virtual Set Editor – installation and registration, a top-level overview of primary 
features, and a hands-on tour to get you started. 
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ABOUT THIS MANUAL 

 

Virtual Set Editor 2.0 provides new and important capabilities, and for the first 
time, is available as a standalone application for use on an external workstation or 
even a laptop. 
 
This manual provides basic information you need to begin working with Virtual 
Set Editor in the introductory Walkthrough section, and goes on to provide a 
comprehensive reference section you can turn to when you need finer detail. 

 

Please take a moment to peruse this section, which explains the manual’s organization.  

Part I – Getting Started: An introduction to TriCaster Virtual Set Editor – a brisk jog through 
fundamentals, including installation and registration, along with a feature walkthrough. If you’re a quick 
study, Getting Started may provide all you really need. 

Part II – Reference: This section covers the finer details of TriCaster Virtual Set Editor – for those who 
need it, and those who just like to know everything. 
 

Part III – Appendices:  Appendix B lists all shortcut keys.  Part III is also home to a question and answer 
section (“How Do I … ?”) and comprehensive keyword index. 
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CHAPTER 1  INSTALLATION AND ACTIVATION 

 

This chapter explains how to properly install your new software, whether for 
integration and use within TriCaster or for standalone operation. 
  
It also reviews registration for warranty, updates and technical support, and 
product activation. After completing this short section, you’ll be all set to continue 
into the Walkthrough chapter that follows it. 

 WELCOME SECTION 1.1

NewTek TriCaster comes with ‘network-class’ virtual sets developed using proprietary NewTek LiveSet™ 
technology. TriCaster Virtual Set Editor (VSE) enables TriCaster TCXD850 and TriCaster TCXD300 users 

alike to customize their high definition (HD) live 
virtual sets. 

Decorate virtual sets with custom logos, modify 
color schemes, furniture options, create custom start 
and end points for zooms, adjust placement and 
scale for video inputs, and even create brand new 
sets from custom graphics files. 

TriCaster VSE is accessed from the TriCaster Startup 
control panel, and is really easy to use.  

Controls such as position, scale, rotation, color 
correction (brightness, hue, contrast and 
saturation), and the Media Browser will be 
immediately familiar to TriCaster users. 

Once a TriCaster virtual set has been customized, you can easily export it for immediate use in live 
production.  NewTek TriCaster Virtual Set Editor permits schools, broadcasters and independent producers 
to personalize their productions – easily and affordably.  

 SYSTEM REQUIREMENTS SECTION 1.2

 
TriCaster VSE 2.0 can be installed on a on a standalone Windows® workstation, or directly on the following 
NewTek TriCaster models:  TCXD300, TCXD450 and TCXD850 (including EXTREME models), TCXD 455 or 
TCXD855, or TCXD 8000.  (You should always check for TriCaster software updates prior to installing new 
Add-ons.) 

 INSTALLATION SECTION 1.3

To begin, let’s review ‘what came in the box’: 

FIGURE 1 
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 USB key 

 Installation instruction card (insert). 

1.3.1 GETTING READY 

1. Power up the system you intend to install VSE on (whether a TriCaster or suitable Windows PC). 
 
2. For a TriCaster setup: 

a. Select the Shut Down icon on the icon ring in the TriCaster Startup Screen’s Home page.  
b. Click the Exit to Windows link at right. 
c. Click the Exit to Windows button in the confirmation dialog that opens next. 

(At this point, the TriCaster Startup Screen exits, and you are taken to the Microsoft 
Windows™ Desktop.) 

3. Insert the TriCaster VSE thumb drive into an unused USB port. 

1.3.2 INSTALLATION STEPS 

4. Click the Windows Start Menu icon at lower left on the Windows® Desktop, and select the 
Computer button (to open a system file explorer). 

5. Double-click the icon for the TriCaster VSE USB thumb drive to open a file window. 
6. Run the installer application by double-clicking the TriCaster VSE Setup.exe icon. 

(On launch, the installer presents various dialogs to ask you to accept the end user license agreement, 
and other information as it proceeds.) 

 

FIGURE 2 

7. Click Next in the introductory dialog to begin the installation process (Figure 2). 
8. Read the License Agreement in the following dialog, and then select I accept the agreement and click 

the Next button to continue. 
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9. The following pane presents the TriCaster VSE readme, which contains version notes for your 
software.  (Some people memorize these to impress their family and friends, but this is not 
mandatory.)  Click Next when you are ready to continue. 

10. The installer will now set up TriCaster VSE on your system.  A progress gauge is shown during 
installation (Figure 3). 

 

FIGURE 3 

 

FIGURE 4 

11. A final dialog announces successful completion of the installation process. 

1.3.3 TRICASTER VIRTUAL SET EDITOR LAUNCH 

TRICASTER 

12. After installation, the TriCaster Startup Screen will automatically appear. 
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FIGURE 5 

13. The icon ring on the Home page now displays an Add-Ons icon – select this icon, and click the Virtual 
Set Editor link at right (Figure 5). 

STANDALONE 

12. By default, a TriCaster VSE icon is shown on the Windows® Desktop after installation. 
13. Double-click this icon to launch VSE (or use the Windows® Start menu to do so). 

1.3.4 REGISTRATION 

14. On first launch (and subsequent launches until registration and activation are complete) the 
registration dialog is shown (Figure 6). 

 

FIGURE 6 

15. If the host system is connected to Internet, you can click the “Click here …” button to perform your 
TriCaster VSE registration online. 

16. Otherwise, note the Product ID shown in this panel, and visit the registration web page (as shown in 
Step 2) to register your software and receive your unlock code. 

17. Click Continue to display the TriCaster VSE desktop. 

Note: Virtual sets can be created before registering and activating VSE, but display a watermark.  To remove 
it, simply re-open the project after activating the software, and then re-save. 
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CHAPTER 2  VSE WALKTHROUGH 

 

This chapter provides a quick hands-on tour of the major components and 
functions of TriCaster Virtual Set Editor. In a very short time, its features and use 
will be second nature to you. 
 
More detailed reference material on all aspects of TriCaster VSE follows in Part II 
(Reference). 

 
Having installed TriCaster VSE in the previous chapter, we’re ready for a little cruise through its highlights. 

 FIRST STEPS SECTION 2.1

As Chapter 1 closed, TriCaster VSE was installed, registered, and activated.  Even without those last two 
steps, you can continue to use TriCaster VSE throughout the 14 day registration grace period.  Note, though, 
that virtual sets created before activation display a watermark.  To remove it, simply re-open the project 
after activating the software, and then re-save. 

1. Launch the Virtual Set Editor, either from the link displayed at right when you click the Add-Ons 
icon on TriCaster’s Startup page, or using the icon on your Windows® Desktop for standalone 
installations. 

 THE STARTUP WIZARD SECTION 2.2

The first thing you will see on launching TriCaster VSE is the Startup Wizard  (Figure 7).  This convenient 
panel makes it a breeze to create a new virtual set project, or pick up where you left off on a recent project. 

 

FIGURE 7 
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The Startup Wizard has two bins. The left-hand one is named Open Recent. Eventually, it will display icons 
for projects you have opened previously.  Initially though, it is empty – apart from Browse and Import 
Photoshop® folder icons (both discussed later). 

The right-hand pane is labeled New Project from Preset, and shows thumbnail icons for all installed virtual 
set presets.  Each preset contains numerous modifiable and optional elements. 

2. Click the icon for the City Loft virtual set preset. 

 

FIGURE 8 

A progress gauge is shown as the various elements constituting the selected preset are loaded.  In just a few 
moments, the default City Loft set is shown on the large Virtual Set Canvas that consumes the biggest part of 
the TriCaster VSE Desktop  (Figure 8). 

 VSE DESKTOP TOUR SECTION 2.3

3. Stop and take a look around the VSE Desktop.  The dominant feature is the Virtual Set Canvas, which 
is a large interactive preview pane – but take note, too, of the following additional details: 
 

 

FIGURE 9 

4. You will find the File, View and Help menus (Figure 9) at upper-left on the VSE Desktop. 
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FIGURE 10 

5. The current TriCaster VSE project is identified at the opposite end of the titlebar, next to the [x] 
button (Exit).  Initially, this is simply the name of the preset you opened. 
 

6. Clicking Exit returns you to the Home page of TriCaster’s Startup Screen, after first prompting you to 
Save your project (when appropriate),. 

 

 

FIGURE 11 

7. Figure 11 shows the Angles Bin, located at left in the VSE Desktop footer (beneath the large Virtual Set 
Canvas). These icons allow you to select which one of the angles included in the preset (such as Left, 
Center, Right, and so-on) to edit. 

 
FIGURE 12 

8. The Presets control group is located at left 

in the Desktop footer (Figure 12).  These 

controls allow you to set custom Shot 

positions, effectively LiveSet zoom/pan 

presets. (Clicking the thumbnail opens the 

Shot selector. 

Standalone and TriCaster™ 8000 installations support 9 different shots, while all other systems will 
show just 2. 

9. The Control Stack  (Figure 13) occupies a 
column on the left side of the VSE Desktop. 
This pane shows a labeled header row for 
each and every editable item in the currently 
loaded project.   
 
Every header row, in turn, has a triangular 
gadget at left, which you can click to expand or 
collapse the controls for each item.  

FIGURE 13 

 
10. Go ahead and click this triangle in the Monitor control header. Observe that the control group expands 

to reveal a bevy of adjustable settings. 
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11. Click a Monitor expand/contract triangle again to close the group. 
 

 
FIGURE 14 

12. In fact, let’s remove the virtual monitor from this scene entirely.  To do that, click the checkmark at 
right in the Monitor header to remove it (Figure 14).   

 

 
FIGURE 15 

The monitor vanishes from the scene (as shown by our somewhat ethereal but nonetheless lovely and 
talented stand-in) – see Figure 15. 
 
Let’s make some additional modifications to the scene.  There are endless possibilities, but next let’s do 
something about the placeholder logo on the brick wall, behind our talent stand-in. 
 

 
FIGURE 16 



 

Page | 15 
 

13. Turn your attention back to the Control Stack, please, and expand the Wall Logo control group (Figure 
17) by clicking the triangle gadget at left in its header. 
 

 

FIGURE 17 

Now, if your client is named “INSERT IMAGE”, you’re finished.  Most, however, will prefer to supply a 
different logo.  For demonstration purposes, let’s replace the placeholder image with one of the default 
images that comes with TriCaster. 

14. Click the drop-down menu labeled Source in the Wall Logo control group, and select Browse.  This opens 
the familiar TriCaster Media Browser (Figure 18). 
 

 

FIGURE 18 
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15. Select the NewTek entry shown beneath the header Stills in the Locations column at left. 
 

16. In the File Pane at right, locate the icon named NewTek Logo.png, which you will find in the Logos 
category; click the OK Button. 

 

 

FIGURE 19 

17. Drag the Scale numeric slider for X or Y to around 70% (Figure 19) and the result should look much like 
Figure 20. 

 

 
FIGURE 20 

 
FIGURE 21 

 
 
18. Change the Style setting to Ignore Room Lights, re-select the logo file as Source, and observe that 

shadows no longer appear on the logo - Figure 21. (You may well prefer the natural shading, but we did 
want to show you what this control does.) 
 

 
 FIGURE 22 
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Let’s notice another useful TriCaster VSE attribute – item hinting. 

19. Roll your cursor over the Brick Wall header in the Control Stack.  The header brightens even before you 
click it. Notice, too, that the item that is highlighted in the Control Stack is also highlighted in the Virtual 
Set Canvas.   
 
Item hinting makes it easy to see what each group in the Control Stack affects, making it a breeze to 
select the correct item for editing. 
 

 
FIGURE 23 

20. Until now, we’ve been viewing the default (first) Shot position for this set.  Locate the Animation 
Controls group at lower left, just beneath the Control Stack. Click the thumbnail icon to reveal the 
expanded Shot selector (Figure 23), and pick a shot to edit. 

 
(Note that the number of thumbnail icons shown in the Shot selector depends on the type of system 
VSE is installed on; more on this in the Reference section of this manual.)  

 
21. Expand the Background group now, and (using the same technique as for the logo image), replace the 

default cityscape image with Jax Sunset.jpg file (located in NewTek>Stills). 
 

 
FIGURE 24 
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22. That looks great, but we can do a little better yet.  Let’s adjust the background image placement slightly.  

Set Position X to -13% and Position Y to -35%. 
 

23. We’ll work with Input A (the talent input) next.  Expand the Input A header in the Control Stack, and use 
the Scale and Position settings to modify the scene roughly as shown in Figure 24. 
 
Having scaled the Input A frame to a smaller size, and perhaps more off-
center than desirable, we should take steps to ensure that the Shot we’re 
currently editing is framed to produce the desired result. 

 
24. First, to help with placement, click the View menu at left above the Canvas, 

and turn on the 16:9 Safe Area overlay (Figure 25). 
 
25. To ‘move the world’ left, right or up and down, simply drag the cursor over 

the Canvas with the left mouse button held down.  Using the Safe Area overlay as a reference to center 
things tastefully. 

 

 

FIGURE 26 

26. You may feel that the zoom level needs to be tweaked, as well. There are several ways to do this; for 
now, simply drag up or down on the Canvas with the right mouse button depressed until you’re happy 
(Figure 26).  

 
27. Click a different thumbnail icon in the shot menu to preview the animated zoom, demonstrating the end 

result of all your modifications. 
 
We could continue endlessly, but let’s finish up at this juncture by saving our VSE project, and then 
exporting our newly modified set for direct use in TriCaster. 
 
28. Click the File menu label above the Canvas, and select Save As. 

 

FIGURE 25 
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FIGURE 28 

29. Accept the suggested name or supply a new one (such as “City 
Loft Jax”, without the quotes) in the Save As dialog that 
appears, and click Ok.  A brief progress dialog will let you 
know when saving is complete. 
 

30. Now select Export to live > This TriCaster from the File menu.  
The exported LiveSet will be listed in the LiveSet section of the 

Live Desktop’s Media Browser afterward. 
 

 
FIGURE 29 

31. Click the Exit button in the upper right corner to close TriCaster Virtual Set Editor. 
 

32. Select Open (or New) on the icon ring in TriCaster Startup’s Home page.  Then click Live on the 
Session page to launch the Live Desktop. 

 

 
FIGURE 30 

All that remains is to test out your new custom virtual set.  You’ll find it listed in the Media Browser’s File 
Pane when you click the new User entry listed under the LiveSets header at left. 
 

FIGURE 27 
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P A R T  I I  ( R E F E R E N C E )  

A thorough examination of TriCaster Virtual Set Editor; every button, menu item, feature and control is 
considered in this section, so you can take full advantage of your software. 
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CHAPTER 3  FEATURES AND CONTROLS 

 

TriCaster Virtual Set Editor is quite straightforward to use, and this is especially 
true if you are already familiar with common TriCaster controls and features. 
 
In this chapter, we’ll discuss each area of the application, explaining how the 
various controls operate and what effect they have, and revealing a few little 
tricks that you may find helpful along the way. 

 STARTUP WIZARD SECTION 3.1

 

FIGURE 31 

Whenever you launch TriCaster Virtual Set Editor, the Startup Wizard provides convenient and quick 
options.  The Open Recent pane at left displays icons for projects you have been working on lately.   

Initially, the bin is empty, apart from a folder icon named Import Photoshop®. 

 

FIGURE 32 
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 The ability to Import layered Photoshop® files (.PSD) and convert them to LiveSets delivers 

amazing creative power.  Helpful details are provided in Section 3.7 of this manual. 
 

 The Browse button at the bottom of the dialog lets you navigate to suitable content located 
elsewhere on your system. 

The New Project from Preset bin at right shows all of the installed VSE Presets, and allows you to open a new 
project based on your selection with a single click. 

 

FIGURE 33 

Let’s take a closer look at the various components of TriCaster Virtual Set Editor’s Desktop. 

 MENUS SECTION 3.2

3.2.1 FILE 

 

FIGURE 34 

The File menu, important as its functions are, hides no mysterious secrets.  Let’s review each entry it offers 
in turn. 
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FIGURE 35 

 The Open menu point presents TriCaster VSE’s Recent and Preset panel again, to allow you to open a 
new project from a preset or one of your previously modified projects. 
 

 Selecting Recent from the File menu shows a list of the latest projects that you have worked on, 
making it easy to jump to one of them in its last-saved state. 
 

 Save and Save As are similar and familiar – use the latter to save the currently open VSE project file, 
or the latter to save it under a new name. 
 

 Selecting Export to live … compiles the shots for the current TriCaster VSE project, and sends them 
to the proper location for use in the Live Desktop.  The process can take some time to complete, and 
progress gauges are shown.  
 
 The export sub-menu displays This TriCaster (for a local host), and then lists any other qualified 
TriCaster systems on the same network (sub-net) below.  The latter feature appears for standalone 
VSE installations as well, allowing graphics artists to instantly update different TriCasters on their 
local network. 
 

 Create Installer allows you to set and select file attributes and content such as readme files, etc., 
then asks for an export path, and finally bundles up the LiveSet as an executable installer file for use 
on a remote TriCaster (a great way to distribute custom LiveSets to clients). 
 

 Finally, Exit closes TriCaster VSE, returning you to the Startup Screen. 
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3.2.2 VIEW 

 

FIGURE 36 

The View menu selections toggle different Virtual Set Canvas guides on and off, as described below. 

 The 16:9 and 4:3 Safe Area guides make it easy to see what parts of the overall canvas will appear in 
the frame on corresponding HD and SD devices.  The inner rectangle represents a Safe Text guide, 
while the outer one marks a Safe Action area. 

 The Center Cross divides the screen into quadrants, and makes it easy to ensure you have things 
properly aligned on the X and Y axes. 

3.2.3 HELP 

 

FIGURE 37 

 The View Help item in this menu opens this manual for convenient review. 

 Selecting Online Help displays a QR code, allowing you to view the very latest version of the manual 
on a mobile device. 

 Select About Virtual Set Editor to review various details related to TriCaster VSE, including credits. 

 Finally, use the Check for Updates item (when connected to the Internet) to ensure you are running 
the latest release of the software. 

 ANGLE BIN SECTION 3.3
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FIGURE 38 

 

FIGURE 39 

Many presets offer more than one camera angle on a virtual set, and you can modify any or all of them at 
will. To switch to a different angle, simply highlight its icon in the Angles Bin by clicking it.  The 
corresponding view will appear on the Canvas, ready for you to edit its attributes. 

 

FIGURE 40 

To rename an angle, right-click its icon in the bin, and select Rename (Figure 40). 

 CONTROL STACK SECTION 3.4

The Control Stack contains nested controls for different set elements that can be modified, or even disabled.  
Even so, it’s quite easy to use, as similar attributes present similar controls in the various sets.  We’ll 
consider the way these work, and leave the creativity to you. 

Let’s take a closer, using a typical example – the Monitor group from the City Loft set preset. 

3.4.1 ITEM HEADERS 

 

FIGURE 41 

Initially, all we see of the Monitor control group is its collapsed header (Figure 41).  As you know, you can 
expand this by clicking the triangle gadget at left, which twirls downward and reveals the nested controls 
when you do so. You may find it even faster to simply double-click the group header.  Like the triangle 
gadget, this expands or contracts the group.  

Additionally, take note of the bright checkmark at the extreme right end of item headers. As we saw back in 
the Walkthrough Chapter, clicking the checkmark toggles the item (or group) on or off, indicating that the 
feature is either enabled or disabled. 
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Hint: You’ll recall that group headers highlight as you roll the cursor over them, and that the corresponding 
feature will also highlight on the Canvas as you do so.  Some local items nested within a control group also 
provide this handy behavior. 

SOURCE MENU 

When the group is expanded, we see that its first option is labeled Source.  Clicking the currently assigned 
source (in this case, Input B), reveals a drop-down menu that allows you to specify a different source to 
display on the monitor.  Typically, monitors in virtual sets really are used to display a video source, and you 
can select a specific input here.   

Note: The inputs shown in the list vary – some TriCaster installations will list just two inputs as available (A 
and B), while others show four, as appropriate for the TriCaster model.   

Standalone installations show four available inputs. However, when exported LiveSets are used on TriCaster 
models that do not support four LiveSet inputs, only A or B selections will work as expected. 

 

The Opacity slider defaults to 100%, or fully opaque.  Reducing 
the value makes the object increasingly transparent. Observe also 
the Keyable switch.   This is an important option.  When enabled, 
Keyable tells TriCaster you wish the TriCaster operator to be able 
to applying LiveMatte (chromakeying) to the input. 

Selecting Browse opens TriCaster’s custom Media Browser, which 
allows you to select an image from any existing TriCaster session, 
including ‘grabs’ from live video, imported images and graphics, 
user-added Locations, and so on. The Recent menu point allows 
you to quickly re-locate an image file from among those you have 
selected recently. 

 

3.4.2 POSITION, SCALE, AND ROTATION 

 

FIGURE 43 

Next we see a Position control group, with Position, Rotation and Scale sections, respectively.  

 Click and drag on the Position button (identified by a double-headed arrow) to relocate the assigned 
source vertically or horizontally within its frame on the Canvas. 

FIGURE 42 



 

Page | 29 
 

 By dragging left or right on the X and Y numeric sliders at right, you can adjust the position on a 
single axis at a time. 

 Alternatively, you can constrain the action to one axis when dragging on the double-headed arrow 
button by holding down the Ctrl key before dragging. 

Hint: If you click a numeric field (or right-click it), you can type a value into the field using the keyboard – 
press Enter to complete the editing action, or Esc to cancel it). 

Dragging the cursor on the Scale button (magnifying glass) affects the scale of the overlay.  

 When the nearby lock button is enabled, dragging in any direction affects size equally on both axes. 

 Otherwise, dragging vertically changes the height of the overlay, and dragging horizontally affects 
its width. 

 Again, drag just one of the numeric gadgets next to the Scale button (with lock disabled) or hold 
down Ctrl when dragging over Scale to independently modify just one dimension of the item (width 
or height). 

In similar fashion, drag the pointer over the Rotation button with the left mouse button pressed to turn the 
overlay source in 3D space, as follows: 

 Drag left/right to rotate the source about the Y (vertical) axis. 

 Drag up/down to rotate the source about the X (horizontal) axis. 

 Drag up/down while holding down the right mouse button to rotate about the Z axis. 

 Drag on a single numeric slider at right, or hold down Ctrl while dragging to constrain rotation to 
one axis. 

Position, Rotation and Scale can be reset by clicking Reset Positioning. 

Hint: Reset most controls to their default value by holding down Shift while double-clicking it. 

3.4.3 PROC AMP 

 

FIGURE 44 

Brightness, Hue, Contrast and Saturation controls are familiar from TriCaster’s Live Desktop, where they are 
located in the Proc Amp controls for inputs. 

 Brightness: Adjustment range from -100 to +100 IRE (the default being 0). As reference, the full 
luminance range of the visible portion of a video signal can be thought of as ‘100 IRE units’ (named 
for the Institute of Radio Engineers) – ignoring minor regional variations. 
 

 Contrast – Adjustment range from 0 - 500% (default 100%). 
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 Hue – Adjustment range from -180° to +180°.  Adjusts the master color of the selected Source, 
swinging the entire image through the color wheel’s spectrum. 
 

 Saturation – Adjustment range from 0-500%.  Zero saturation results in a ‘black and white’ picture; 
increased saturation results in richer colors. 
High saturation values can exaggerate the color portion of the signal.  Note that over-saturated 
colors are considered illegal for broadcast transmission, and may result in display problems on 
some devices.  

(The result of clicking Reset Color will come as no great surprise, so perhaps we’ll leave that as a student 
exercise.) 

3.4.4 STYLE 

A Style menu doesn’t appear in the Monitors group, but we should give it a moment’s attention as well.  
Expand the Input A control group to show it. Style is a bit of a joker, since it may govern different features in 
various places.   

One very useful thing it offers in some instances is that it permits you to select between a one-person or a 
two-person frame overlay on the Virtual Set Canvas.  Elsewhere, it may be used to provide other options, 
such as enabling or disabling lighting effect.  Be sure to check it out wherever it appears. 

 ANIMATION CONTROLS SECTION 3.5

We reviewed the use of the Animation Controls (Figure 45) in the Walkthrough Chapter.  The thumbnail 
icon shows the active zoom/pan preset position, which is also a) seen on the Canvas and b), highlighted 
with a blue border in the Shot selector that opens when you click the thumbnail icon. 

 

FIGURE 45 

Edits made to the composition of the current preset take effect immediately.  Clicking a different thumbnail 
in the Shot selector begins an animated zoom preview right on the Canvas.    

Notice, too, that you can right-click a Shot menu thumbnail to open a context menu offering Copy and Paste 
features.  This makes it a simple matter to duplicate a shot, and then tweak the new iteration to taste. 

Note: The first and last presets serve as Start and End (min and max zoom) positions for TriCaster models that 
do not support all nine preset shots.  
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 VIRTUAL SET CANVAS SECTION 3.6

The large Virtual Set Canvas dominates the screen.  It not only provides feedback on your work in progress, 
but also supports certain editing operations, and even allows you to preview animated zooms.  In addition, 
as previously mentioned, various objects on the Canvas may be highlighted when you roll the mouse cursor 
over their respective headers in the Control Stack. 

 

 

FIGURE 46 

The Canvas allows you to interactively adjust the zoom level and center frame point for the Start and End 
positions. 

When zoomed out to the maximum level for the set, dragging the cursor on the screen has no effect.  As 
soon as you have zoomed in a bit, though, you can drag left, right, up or down to re-center the frame – in 
essence relocating its target point. 

There are several ways to zoom in and out and pan on the Canvas:  

 Hold down the right mouse button, and drag up or down. 

 If you mouse has a scroll-wheel, rotate it to zoom in and out. 

 Press Ctrl with the + or – keys (top row plus and minus sign). 

 Hold down the Alt key, and drag up or down. 
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 IMPORTING PHOTOSHOP® FILES SECTION 3.7

 

FIGURE 47 

As mentioned earlier, TriCaster Virtual Set Editor can also import PSD files, and create LiveSets from them.  
This is extremely useful, since it permits users to prepare layered files for conversion to LiveSets using 
familiar 2D art software. 

 
FIGURE 48 

 
 
Note that the order of layers in the Control Stack for PSD files you import is inverted compared to the 
original – so, for example, the Background layer is at the bottom of the Layer Panel in Figure 48, but will 
appears at the top of VSE’s Control Stack after import. 

 

3.7.1 FILE REQUIREMENTS 

There are a few things to know about working with PSD files in TriCaster VSE.  Generally, all layers in the 
file should be rasterized (i.e., bitmap layers, not employing transfer modes, etc.).  Also, images should be 
RGB Color Mode (not CMYK, etc.). 



 

Page | 33 
 

3.7.2 INPUT LAYERS 

For TriCaster VSE purposes, image layers in the file serve one of two purposes.  Either a layer contains 
graphic imagery that will for part of the composite result, or it is an “Input Layer”.  Input layers are 
replaced by the video sources assigned in TriCaster’s Virtual Input tab in the finished LiveSet.  TriCaster 
VSE identifies input layers in imported PSD files by their layer name. You can use the name to identify the 
layer as a proxy for either Input A or Input B. 

A layer with any of the following names will be replaced by Input A: "Input A", "InputA", or their lower case 
equivalents.  When the PSD file is imported, input layers are listed in TriCaster VSE’s Control Stack as “Input 
Layer 0”, “Input Layer 1”, and so on.  It’s also possible to assign a custom name to a video input layer when 
creating VSE projects from Photoshop® files.  Simply assign the layer a name as shown on the lines below: 

Input A name = “Stand-up Talent” 

or, as another example:  Input B name = “PiP” 

Add the word “keyable” to a video input layer in a PSD file will enable the Keyable switch on import into 
VSE. (Failure to use this keyword simply means the layer won't initially have Keyable checked; it does not 
prevent you from changing the switch setting later in VSE.)  Consider some layer name examples: 

Input A Keyable 

input b name = "Talent" Keyable 

input d keyAble name="No Talent" 

 
Note: The "Input x" designation must come first on any input layer.  Modifiers such as a custom name or 
“keyable” can come in any order after that. 
 

LAYER GROUPS 

On conversion, Photoshop® image layers that are nested inside groups will be organized into similar 

groups under headers in TriCaster VSE’s Control Stack.  This is a useful way to make it easier to manipulate 
VSE layers. 

MULTI-ANGLE LIVESETS 

Specially named groups (folders) in Photoshop® PSD files can be used to create VSE project s with 

multiple angles. Let’s consider an example.  Suppose your PSD file contains a group named as follows: 

Angle="Left" 

 
On import into VSE, you will see an angle named “Left” in the Angles Bin, and its Control Stack content will 
reflect the layer structure of the group.  Optionally, append the keyword “default” to the group name to 
make this the default angle when the project is loaded into VSE. For example: 

Angle="Center" Default 
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It is possible to use a single group to provide layers for more than one virtual set angle.  For example, if the 
angle name is set to “left, right”, or “left, center, standing”, the group will supply content to all of the named 
angles on import.  Similarly, if a PSD file includes both individual layers along with angle groups, the un-
grouped layers will appear in every angle of the VSE project. (Note that nesting angle groups inside other 
groups will generally result in missing layers).   

Finally, angle group names can also be used more than once in a PSD file (i.e., two or more groups can share 
the same name).  ‘Same name’ groups will be treated as though they were a single, merged group, and will 
result in a single angle in the VSE project after importing. 

DISTORTION AND WARPING 

IF YOU HAVE A RECENT VERSION OF PHOTOSHOP® THAT SUPPORTS INPUT AND OUTPUT OF HIGH DYNAMIC 

RANGE IMAGERY, MORE ELABORATE TRANSFORMATIONS OR DISTORTIONS ARE POSSIBLE (FIGURE 49).    

You will find a file named “VSE UV Gradient.exr 
supplied in your TriCaster VSE installation folder 
(specifically, in the folder C:\TriCaster\AddOns\Virtual 
Set Editor\Extras). 

This special image is a UV gradient in the form of an 
OpenEXR file.  It is intended to serve as a proxy video 
input layer proxy in your Photoshop®project when you 
need more powerful input layer transformations.  

 

The Photoshop project must be 16bit color depth (or 32bit) when you load the .exr file (save the final 
layered PSD in the same color depth to preserve your transformations and distortions accurately).  
Remember to use the (.exr) proxy gradient for all video input layers in the project in this case, with one 
exception: completely empty (transparent) layers will be treated as a full-frame video input layer. 

Hint:  When you do not require advanced transformations, simply use standard 8bit color depth for both 
project and file exports. Only the opacity in input layers is recognized by TriCaster VSE in this case; any color 
information is ignored. 

INPUT LAYERS, PROXIES, AND OPACITY  

In the assumption that Input A is most often used for greenscreen shots, imported Input A layers display 
the ‘phantom’ One Person proxy on the Canvas by default  (and in the icon for the resulting LiveSet).  You 
can select a different proxy image for the layer from the Style menu if you wish. 

Note that if an input layer is completely empty, TriCaster VSE infers a full screen input.  On the other hand, 
if the layer contains a smaller opaque shape on a transparent field, TriCaster VSE attempts to position the 
live video accordingly in the result.  

If a solid color input layer is neither completely empty nor fully opaque, transparency is applied to the 
video source as appropriate.  If the filled shape does not truly correspond to the rectangular aspect of your 
video sources, you may find it useful to use TriCaster VSE’s Position (and Scale) tools to tweak the video 
source within the shape. 

FIGURE 49 



 

Page | 35 
 

Hint: While this means you need to avoid inadvertently leaving just a few stray pixels in a layer, it also means 
that you are perfectly free to design Picture in Picture effects from all manner of different shapes – circles or 
ellipses, squares, soft-edged vignettes, and so on. 

An additional consideration: input layer conversions work on the basis of opacity in the layer at this time. 
Distortions (such as warping, rotation, smearing, etc.) in the image layer are not recognized by VSE. 

Caution: Care must be taken if a video input is referenced more than once in the file. Distortion can occur in 
the result if ‘same source’ layers overlap. Unless the foremost ‘same source’ layer (from the viewer’s 
perspective) – or an intervening layer – is fully opaque (i.e., has no transparency at all) where the overlap 
occurs, problems will ensue. 

KEYING 

If the Keyable switch is set in TriCaster VSE for an input source, when the resulting LiveSet is displayed in 
TriCaster’s Live Desktop, the background behind it in the LiveSet will be seen (Figure 51) when LiveMatte is 
correctly configured and applied. 

 
FIGURE 50 

 
FIGURE 51 

With LiveMatte disabled, the video source will obscure the background, just as you would expect.   

 
PERSPECTIVE EFFECTS 

It might be that you wish to apply a perspective effect to a video input.  You will find it works best to simply 
supply a full-screen layer in this case, and do the positioning using TriCaster VSE’s Control Stack. 

 

FIGURE 52 

However, if you want a shadow (as in Figure 52), frame, or similar graphic element to be rotated or skewed 
to match a rotated input layer, this must be prepared in the source file before import.  (Afterward, use the 
Position controls to adjust the input layer to match, or use the UV gradient image to map the layer to match 
as discussed earlier.) 
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P A R T  I I I  ( A P P E N D I C E S )  

A time-saving question and answer section, followed by an extensive listing of Shortcut Keys, schematic 
diagram and keyword index … 
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A HOW DO I … ?  

 

In this section, we’ll consider the most common questions TriCaster Virtual Set 
Editor users may have (and of course we’ll provide the answer, too). 
 
The answers are intentionally brief – perhaps just a reminder of one or two steps 
required to perform some operation. For this reason, we’ll also point you to 
explanatory information elsewhere in this manual whenever that would be useful. 

 
If you’ve largely mastered your TriCaster VSE but have a specific question, this may be the best place to 
look first.  The headings that follow list related questions and answers together, along with cross-
references and other helpful remarks. 

Hint: The NewTek website includes a comprehensive FAQ database containing a wealth of useful information 
on all of its products – please see http://www.newtek.com/faq/  

How do I ... 

VIRTUAL SETS .............................................................................................................. 39 

ADD MORE VIRTUAL SET PRESETS? ........................................................................................... 39 

ADD A BACKGROUND TO MY SECOND DOUBLE-BOX? ................................................................... 39 

CREATE A A COMPLETELY CUSTOM VIRTUAL SET? ........................................................................ 40 

FILE MANAGEMENT ...................................................................................................... 40 

LOCATE MY NEW VIRTUAL SETS IN TRICASTER’S LIVE DESKTOP? .................................................... 40 

ORGANIZE VIRTUAL SETS IN CUSTOM LOCATIONS? ...................................................................... 40 

DELETE UNWANTED VIRTUAL SETS? .......................................................................................... 40 

 

A.1 VIRTUAL SETS 

A.1.1 ADD MORE VIRTUAL SET PRESETS?  

NewTek may offer optional content packs with more virtual set presets from time to time.  The new presets 
will be installed to the correct location on your TriCaster automatically. 

A.1.2 ADD A BACKGROUND TO MY SECOND DOUBLE-BOX?  

Some TriCaster models support two inputs into virtual sets, while other models support four.  For the 
former, you can apply LiveMatte to Input A (only) in the Virtual Input tab (Live Desktop), the background 
behind it appears wherever the chromakey settings result in transparency.  On those models (i.e., those 
supporting just two inputs in virtual sets), it is not possible o to successfully apply LiveMatte to a source set 
to Input B. 
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A.1.3 CREATE A COMPLETELY CUSTOM VIRTUAL SET? 

The primary raison d’être for TriCaster VSE is to allow TriCaster users to easily customize LiveSets to their 
local need.   In addition, it allows users to create completely custom virtual sets by importing layered 
Adobe® Photoshop® PSD files (see Section 3.7). 

Beyond this, it is not anticipated that most users will wish to pursue custom LiveSet authoring.  In some 
cases, users may utilize specialist services offered by various third-party developers rather than 
endeavoring to master the skills (and tools) required. 

A.2 FILE MANAGEMENT 

A.2.1 LOCATE MY NEW VIRTUAL SETS IN TRICASTER’S LIVE DESKTOP?  

1. When you perform an export operation, the newly created virtual set is stored in the User folder at 
the default LiveSet effects location on the system. 

2. Open a TriCaster session, and click a Virtual Input tab. 
3. Click the Add button in the Virtual Input tab, to show the Media Browser. 
4. You will see a User sub-heading listed (along with NewTek) under the LiveSets header in the 

Location List at left in the Media Browser. 
5. Click the User location entry and icons for your new LiveSets will be shown in the File Pane at right. 

A.2.2 ORGANIZE VIRTUAL SETS IN CUSTOM LOCATIONS?  

1. To move your virtual sets to custom locations, select the Shutdown icon on the Home Page of 
TriCaster’s Startup Screen, select Exit to Windows, and confirm this decision. 

2. Navigate from the Windows Desktop to C:\TriCaster\Effect\LiveSets. 
3. Create a new sub-folder with the custom name you wish to appear alongside NewTek and User in 

the Media Browser Location List (under the LiveSets header). 
4. Drag the folder(s) for the LiveSet you wish to appear in the custom location into the new folder you 

created earlier. 
5. Then simply re-launch TriCaster, and re-open your session.  The newly created folder will appear as 

a sub-heading in the Media Browser’s Locations List, and its content will be displayed in the File 
Pane at right when you select it. 

A.2.3 DELETE UNWANTED VIRTUAL SETS?  

1. You may create some virtual sets that, for one reason or another, are not ‘keepers’.  To remove them 
from TriCaster entirely, select the Shutdown icon on the Home page of TriCaster’s Startup Screen, 
select Exit to Windows, and confirm this decision. 

2. Navigate from the Windows Desktop to C:\TriCaster\Effect\LiveSets. 
3. Locate the folder for the LiveSet you wish to delete, then simply right-click on it and select Delete 

from the context menu. 
4. Re-launch TriCaster.
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B KEYSTROKE SHORTCUTS 

 

B.1 MENU OPERATIONS 

 
New Ctrl + n 
Open Ctrl + o 
Save Ctrl + s 
Save As  Ctrl + S (Shift + s) 
Close Alt + F4 
Help F1 

 

B.2 VIRTUAL SET CANVAS 

 

Zoom In  Ctrl + (plus sign) 
Zoom Out Ctrl - (minus sign) 
Drag to zoom Alt + drag mouse 

up/down 
Constrain dragging (panning) Hold Shift before 

dragging 

 

B.3 CONTROL STACK 

 

Reset control to default value Shift + double-click 
Constrain drag operation (pan/scale direction, rotation 
axis) 

Hold Ctrl before 
dragging 

 

B.4 ANIMATION CONTROL  

 

Jump to current Start preset position Home 
Jump to current End preset position End 





 

 

C VERSION NOTES 

This section lists changes and features that are new in this version: 

 Support for 4 video inputs 

 Create LiveSets that work in any current HD TriCaster model 

 Respects masks in PSD file layers. 

 Updated interface 

 Input layers with "keyable" keyword appended are marked keyable in the VSE project. 

 Supports masks in PSD layers 

 New Shot thumbnail menu; prepare zoom and pan presets for TriCaster 8000 

 Export virtual sets as LiveSet installer (.exe) files 
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